© 2015 UNIVERSITY OF SOUTHERN CALIFORNIA. All rights reserved.

This manual, as well as the data and software implementation described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment on the part of the University of Southern California.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of the University of Southern California.

The data and software implementation, as with all technical and computer-aided design software, is a tool intended to be used by trained professionals only. The data and the software implementation is not a substitute for the professional judgment of trained professionals. The software implementation is intended to assist with product design and is not a substitute for independent testing of product stress, safety and utility. The University of Southern California assumes no liability for any error or inaccuracies that may appear in this manual. The University of Southern California makes no warranties with respect to this manual and disclaims any implied warranties of merchantability and fitness for a particular purpose.

U.S. Government Customers:

The Products are provided to the Federal government and its agency with RESTRICTED RIGHTS. USE, DUPLICATION OR DISCLOSURE BY THE GOVERNMENT IS SUBJECT TO RESTRICTIONS SET FORTH IN SUB-PARAGRAPH (c)(1)(ii) OF THE RIGHTS IN TECHNICAL DATA AND COMPUTER SOFTWARE CLAUSE AT DFARS 252.227-7013 OR SUB-PARAGRAPHS (c)(1) OR (2) OF THE COMMERCIAL COMPUTER SOFTWARE-RESTRICTED RIGHTS AT 48 CFR 52.227-19, AS APPLICABLE.
# TABLE OF CONTENTS

Chapter 1: About Skype for Business ................................................................. 5

Chapter 2: Navigating Skype for Business for Windows ..................................... 6

  Interface Basics .................................................................................................................. 6
  Status Message .................................................................................................................... 8
  Status Field .......................................................................................................................... 9
  Set Your Location Menu ..................................................................................................... 11
  The Options Menu ............................................................................................................. 12

Chapter 3: Navigating the Message Window ......................................................... 17

Chapter 4: Sending a Message .................................................................................... 20

  Sending a Message ............................................................................................................ 20

Chapter 5: Working With Skype for Business Contacts .......................................... 22

  Viewing and Adding Contacts ......................................................................................... 22
  Create a New Contact Group ............................................................................................ 27

Chapter 6: Skype for Business Options Menu ....................................................... 30

  The General Options ............................................................................................................ 31
  Conversation Window Settings ......................................................................................... 32
  Help Us Improve Settings ................................................................................................. 32
  Help Your Support Team Help You Settings .................................................................... 33
  Application Window Settings ............................................................................................ 33
  The Personal Settings .......................................................................................................... 34
  The Personal Information Manager Settings .................................................................... 35
  The Location Settings ......................................................................................................... 37
  The Show Pictures Settings ............................................................................................... 37
  The Contacts List Settings ................................................................................................ 38
  My Contacts List Settings ................................................................................................. 39
  Order My List Settings ..................................................................................................... 39
  Show This Information Settings ....................................................................................... 40
  The Status Settings ............................................................................................................ 41
  My Picture Settings ............................................................................................................ 43
  Edit or Remove Picture ..................................................................................................... 44
  The Phones Settings .......................................................................................................... 46
  My Phone Numbers Settings ............................................................................................ 47
  The Phone Integration Settings ........................................................................................ 48
  The Phone Accessibility Settings ...................................................................................... 48
  The Alerts Settings ............................................................................................................. 49
  The General Alerts Settings ............................................................................................. 50
  The When my status is Do Not Disturb Settings ............................................................. 50
  The Contacts Not Using Skype for Business Settings ..................................................... 51
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The IM Settings</td>
<td>52</td>
</tr>
<tr>
<td>The Ringtones and Sounds Settings</td>
<td>54</td>
</tr>
<tr>
<td>The Ringtones Settings</td>
<td>55</td>
</tr>
<tr>
<td>The Sounds Settings</td>
<td>55</td>
</tr>
<tr>
<td>The Audio Device Settings</td>
<td>57</td>
</tr>
<tr>
<td>The Audio Device Settings</td>
<td>58</td>
</tr>
<tr>
<td>The Secondary Ringer Settings</td>
<td>59</td>
</tr>
<tr>
<td>The Stereo Audio Feedback Settings</td>
<td>59</td>
</tr>
<tr>
<td>The Video Device Settings</td>
<td>60</td>
</tr>
<tr>
<td>The Video Device Settings</td>
<td>61</td>
</tr>
<tr>
<td>The Video Settings</td>
<td>62</td>
</tr>
<tr>
<td>The File Saving Settings</td>
<td>63</td>
</tr>
<tr>
<td>The Recording Settings</td>
<td>64</td>
</tr>
<tr>
<td>The Recordings Settings</td>
<td>64</td>
</tr>
<tr>
<td>The Image Resolution Settings</td>
<td>65</td>
</tr>
<tr>
<td>The Skype Meetings Settings</td>
<td>66</td>
</tr>
<tr>
<td>The When I Join Meetings Setting</td>
<td>66</td>
</tr>
<tr>
<td>The Meeting Default Settings</td>
<td>67</td>
</tr>
</tbody>
</table>

Chapter 7: Presentation Tools Within Skype for Business       | 68   |

  Presentation Tools                                          | 68   |
  Using the Whiteboard                                        | 70   |
  Creating a Poll                                             | 72   |
  Using the Q & A Feature                                     | 74   |

Chapter 8: The Skype for Business Recording Manager           | 75   |

Chapter 9: Skype for Business for Mobile                      | 77   |

Chapter 10: Skype for Business Browser Plugin                 | 78   |

Chapter 11: Outlook 2013 Integration with Skype for Business  | 79   |

Chapter 12: Skype for Business Web Scheduler Tool             | 81   |

Contact Dornsife Technology Services                          | 85   |

©2015 University of Southern California. All rights reserved.
CHAPTER 1: ABOUT SKYPE FOR BUSINESS

Skype for Business is an internal communication tool from Microsoft. Skype for Business is designed to allow you to communicate one-on-one with other members of your organization, or to host meetings and collaboration sessions with multiple contacts.

Skype for Business is not the same as Skype. Skype for Business contacts must be people within your business or organization. Regular Skype users cannot be added as contacts to Skype for Business. If you wish to meet or collaborate with a non-Skype for Business user, you will need to download and use the regular version of Skype. However, non-Skype for Business users can attend Skype for Business meetings, via an Internet browser plugin, when sent the appropriate meeting link.
CHAPTER 2: NAVIGATING SKYPE FOR BUSINESS FOR WINDOWS

This topic explains how to use the Skype® for Business interface. Use this topic to assist you in navigating the interface.

Interface Basics
The Skype for Business interface contains several symbols and options to assist your use of the application. This topic explains those symbols and fields.

Contacts, Meetings, and Conversations
The upper portion of the Skype for Business window contains several different symbols that, when selected, will quickly open a different part of the Skype application.
The highlighted symbols correspond to the following actions/areas of Skype for Business.

- **Contacts:** The **Contacts** symbol (👥) provides the ability to quickly access your contacts list when working in another area of the application.

- **Conversations:** The **Conversations** symbol (💬) displays all of the conversations you have conducted in Skype for Business. Unless otherwise configured, Skype for Business will retain a log of these conversations that can be accessed at any time by selecting the **Conversations** symbol.

- **Meetings:** The **Meetings** symbol (🗓️), when selected, displays a listing of all the meetings on your Outlook calendar for the day. This provides the ability to quickly view your agenda for the day, without leaving the Lync window.

- **Options:** The **Options** symbol (⚙️) displays the settings within Skype for Business that you have the ability to customize. This screen and the settings are covered in a separate topic.

- **Add a Contact:** The **Add a Contact** symbol (➕) provides the ability to add a contact from the Contact List within Skype for Business.

The last symbol within the Skype for Business interface is the **Select Your Primary Device** symbol. This symbol, located at the bottom of the screen, displays a drop-down menu, when selected. From this menu, you may select the primary microphone and speakers to be used with Skype for Business. Selecting an option from this menu is not required.
Status Message

The *Status* field provides the ability to enter a message or thought to Skype for Business. For example, you might add an informative message, like "out of town between the 18th and 20th," or a greeting, such as "Happy Valentine's Day!"

To enter a status message, place your cursor in the status field and begin typing the message you want to appear next to your name on Skype for Business. When you have finished entering the text, press the **Enter** key. The message is now displayed next to your name on Skype for Business. An example is shown below.
Status Field

Skype for Business provides the ability to manually select a status. Your status indicates if you are available to collaborate and chat with others, or if you are busy or in a meeting. Skype for Business syncs with Microsoft Outlook® and automatically changes your status to correspond to calendar events. To manually set your status, select the Status drop-down menu. An example is shown below.

From the drop-down menu, you can select the appropriate status for your current state. The default status is Available. If you do not select a status or you choose the Reset Status, Available will be the status that is displayed. The status you select also determines whether or not you receive messages at certain times. For example, if you select a status of Do Not Disturb, depending on your settings, you may not receive messages while your status is set to Do Not Disturb.
Select the appropriate status for your current state. The status indicator next to your name will change to the corresponding status symbol, as shown below.

Repeat these steps to change your Skype for Business status.
Set Your Location Menu

The Set Your Location menu provides the ability to display the location from which you are presently working. For example, if you work from multiple locations, you may want to alert your contacts to your present location. Select the Set Your Location menu, as shown below.

The Set Your Location field becomes a text field in which you can type. Enter the text you want to display as your main location.

Press the Enter or Tab key on your keyboard to save the location information you typed.

Multiple custom locations are not saved within Skype for Business. If you update your location, the previous location is removed. Repeat these steps to display a custom location.
The Options Menu

The *Options* menu contains two different menu sets. When the gear (⚙️) icon is selected, the *Options* menu displays. An example is shown below.

When the downward pointing arrow that is on the right side of the gear icon is selected, a pop-up menu is displayed. An example is shown below.

![Pop-up menu example](image)

There are five (5) menu options displayed within the pop-up menu. With the exception of the **Meet Now** and **Show Menu Bar** options, all options contain a sub-menu.
The File Menu
The *File* menu contains several options to enable you to quickly perform actions within Skype for Business. A description of those options is below.

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sign Out</td>
<td>Use this option to sign out of Skype for Business. This option will only sign you out of the Skype for Business network. It will not exit the Skype for Business program.</td>
</tr>
<tr>
<td>Change Sign-In Address...</td>
<td>Select this option to change the stored e-mail address with which you sign into Skype for Business.</td>
</tr>
<tr>
<td>My Status</td>
<td>Select this option to display the Skype for Business Status Menu.</td>
</tr>
<tr>
<td>View Received Files</td>
<td>Select this option to view the files you have received within Skype for Business.</td>
</tr>
<tr>
<td>View Conversation History</td>
<td>Select this option to launch Microsoft Outlook and display the Conversation History folder. This option is only valid if you have selected to save a copy of your Skype for Business conversations to this folder.</td>
</tr>
<tr>
<td>Close</td>
<td>Select this option to close and minimize the Skype for Business window.</td>
</tr>
<tr>
<td>Exit</td>
<td>Select this option to completely exit the Skype for Business application.</td>
</tr>
</tbody>
</table>

Utilize these options as is appropriate.
The Meet Now Option

The Meet Now option within the Options pop-up menu launches a meeting when selected. You can provide the meeting information (located by accessing More Options > Meeting Entry Info) to other individuals that you want to join your meeting session.

The Tools Menu Option

The Tools menu contains several options related to settings and configuration within Skype for Business. A description of those options is below.
<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always on Top</td>
<td>If you want Skype for Business to always appear on top of other windows, select this option.</td>
</tr>
<tr>
<td>Recording Manager</td>
<td>Select this option to launch the Recording Manager.</td>
</tr>
<tr>
<td>Audio Device Settings</td>
<td>Select this option to open the Audio Device Settings.</td>
</tr>
<tr>
<td>Video Device Settings</td>
<td>Select this option to open the Video Device Settings.</td>
</tr>
<tr>
<td>Dial-in Conferencing Settings</td>
<td>Select this option to view the conference settings if you cannot use the audio conferencing within Skype for Business. This information could also be used by non-Skype for Business users to dial into a meeting session.</td>
</tr>
<tr>
<td>Options</td>
<td>Select this option to display the Options settings.</td>
</tr>
</tbody>
</table>

Utilize these options as is appropriate.

The Help Menu
The Help menu contains several options related to obtaining help and tips within Skype for Business. A description of those options is below.

![Help Menu Diagram]
<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skype for Business Help</td>
<td>Select this option to launch the Microsoft-authored help topics.</td>
</tr>
<tr>
<td>Give Feedback</td>
<td>Select this option to provide feedback on your Skype for Business experience.</td>
</tr>
<tr>
<td>Privacy Statement</td>
<td>Select this option to view the Skype for Business Privacy Statement.</td>
</tr>
<tr>
<td>Quick Tips</td>
<td>Select this option to launch the Skype for Business Quick Tips.</td>
</tr>
<tr>
<td>About Skype for Business</td>
<td>Select this option to view the About Skype for Business information.</td>
</tr>
</tbody>
</table>

**Show Menu Bar**

Select the **Show Menu Bar** option to display the menu bar at the top of the Skype for Business window. The menu that is displayed when this option is selected is the same that is available from the **Options** pop-up menu.

Use this topic to assist you when using the **Options** pop-up menu.
CHAPTER 3: NAVIGATING THE MESSAGE WINDOW

The message window within Skype for Business is easy-to-navigate and provides you with several options and contact methods.

To begin, right-click the name of a contact to display a pop-up menu. From the pop-up menu, select **Send an IM**. A new message window displays.

The message window contains buttons and icons with which you can interact to perform specific actions.
In the message text area, there are three options:

- **Paperclip**: Select the paperclip (_attach icon to attach and send a file via instant message.
- **Set high importance for this message**: Select the High Importance (!) icon to send the IM you are composing with a high importance indicator.
- **Choose a Smiley**: Select the **Choose a Smiley** ( 🎉 ) icon to insert an emoticon into the IM you are composing.
- **Send**: Select the Send ( ☑️ ) icon to send a message, after you have finished typing the message. You can also send a message by pressing the Enter key on your keyboard.

At the bottom of the message window is a series of icons. The icons are described below.

- **Messages**: Select the Messages ( 💌 ) icon to send or view your Skype for Business messages with this contact.
- **Call**: Select the Call ( ☎️ ) icon to initiate an audio call with this Skype for Business contact.
- **Video**: Select the Video ( 📺 ) icon to view a preview of your webcam image and begin sharing your webcam feed.
- **Present**: Select the Present ( 🎯 ) icon to share a file or begin a presentation.

The last icon on the Message window is the More Options ( ☰️ ) icon. A pop-up menu displays.
From this menu, you can launch the Recordings Manager by selecting **Manage Recordings**, or adjust the text display by selecting **IM Text Display Size**. Additionally, you can change the font being used in your message by selecting the **Change Font**... option.

Use these icons and options to assist you accomplishing your tasks within Skype for Business.
CHAPTER 4: SENDING A MESSAGE

Sending a message within Skype for Business is simple. It’s also an efficient way to communicate with other department or organization members.

Sending a Message
To send a message, first log into Skype for Business. Your Skype for Business Contact List displays. Right-click the name of a contact to whom you want to send a message. A pop-up menu displays.
Select **Send an IM** from the pop-up menu. A message window displays.

Type the message you want to send to this contact and then press the **Enter** key on your keyboard. The message is sent to the contact.

Alternately, you may also double-click the name of a contact to launch a blank message window.

Repeat these steps to send additional messages.
CHAPTER 5: WORKING WITH SKYPE FOR BUSINESS CONTACTS

Your Contact List is the location from which you can interact with your contacts. You can send them a message, add them to groups, and decide how you want the contacts displayed within Skype for Business. Skype for Business contacts must be other Skype for Business users within your organization. Regular Skype users can be added to your contact list, but you will not actually be able to contact them from Skype for Business. You will need to download and utilize regular Skype, not Skype for Business, to communicate with contacts outside of your organization.

This topic details how to work with your Contact List in Skype for Business.

Viewing and Adding Contacts

Viewing and adding contacts to your Skype for Business list is simple. There are several ways through which you can add contacts to your Contact List. The most direct method is described in this topic.

After logging into Skype for Business, Skype for Business is displayed and appears similar to the following image.

Select the Add a Contact icon.
Select the **Add a Contact** icon, located on the right side of the Skype for Business window. A drop-down menu displays.

The drop-down menu provides several options. You can:

- **Add a Contact in My Organization**: Use this option to add a contact that works for the same company/organization as you.
- **Add a Contact Not in My Organization**: Use this option to add a Skype for Business user that does not work for the same company/organization as you.
- **Create a New Group**: Select this option to organize your contacts into Groups.
- **Display Options**: Select this option to customize your display.
For the purposes of this document, the **Add a Contact in My Organization** option will be selected. After selecting **Add a Contact in My Organization**, the cursor is moved from its current position and placed into the **Find Someone** field, as shown below.
Begin typing the name of the person you want to add as a contact. As you enter characters into the Find Someone field, the results are narrowed to alphabetical matches.
Continue entering characters until you locate the name of the person you want to add to your contacts. Once the name of the person you want to add to your contacts is displayed, right-click on the person's name. A pop-up menu displays.

Select the **Add to Contacts List** option. A sub-menu displays to the right of the original pop-up menu. The sub-menu displays your contact groups. By default, you have an **Other Contacts** group. If you have created any other contact groups, the names of those groups are displayed. Select the name of the group to which you want to add this contact. After selecting a group name, the contact is added to your contact list, in the selected group.

Repeat these steps to add additional contacts to your Contact List.
Create a New Contact Group

Contact groups provide the ability to organize your Skype for Business contacts by an association, such as the department in which they work. Follow these steps to create a new Contact group within Skype for Business.

Log into Skype for Business and select the **Add a Contact** icon, located on the right side of the Skype for Business window. A drop-down menu displays.
From the drop-down menu, select **Create a New Group**. A new field in which you can enter the name of your new contact group is displayed.
Place your cursor in the **New Group** field and begin typing the name of the contact group you are creating. When you are finished entering the contact group name, press the **Enter** key. The contact group is now displayed in the list of available groups.

Repeat these steps to create additional contact groups.
CHAPTER 6: SKYPE FOR BUSINESS OPTIONS MENU

Microsoft Skype for Business contains many settings that you may configure to increase the performance and usability of Skype for Business. This topic details accessing the Skype for Business Options menu and how to adjust each setting. The default settings are enabled upon the initial installation of Skype for Business. Follow the steps in this topic to adjust your Skype for Business settings.

To begin, you will need to open the Options window. From the main Skype for Business window, select the Gear (⚙️) icon, located on the right side of the screen. The Options window displays.

The Options window has 14 configurable areas, displayed on the left side of the screen. By default, the General options are displayed.
The General Options

The General options provide the ability to configure options related to the way Lync functions. There are four sections within the General options. Configure all four sections, as is appropriate.
Conversation Window Settings

The default settings for this area are shown below. You are not required to change any settings within this area.

<table>
<thead>
<tr>
<th>Conversation window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reopen my conversations when I sign in</td>
</tr>
<tr>
<td>Show call controls when Skype for Business is in the background</td>
</tr>
</tbody>
</table>

There are two (2) options within the Conversation window settings section of the General options screen.

- **Reopen my conversations when I sign in**: If you use Skype for Business to communicate with the same contacts daily, you might want to have conversation windows open when you log into Skype for Business.
- **Show call controls when Skype for Business is in the background**: If you want to display shortcuts for the Skype for Business call controls when Skype for Business is running in the background, select this option.

Help Us Improve Settings

The Help us improve settings provides the ability to send Microsoft information about how you use Skype for Business and other Microsoft products.

The **Sign up for the Customer Experience Improvement Program** checkbox is available for selection. After reading the terms and conditions of the program by selecting the Learn More hyperlink, if you want to participate, select the checkbox. Participating in this program is voluntary and at your discretion.

Select the **Send Skype for Business Improvement Program info to Microsoft** checkbox if you want to send error logs and other reporting information to Microsoft. Sending this information assists Microsoft in making Skype for Business a better product.
Help Your Support Team Help You Settings

The *Help your support team help you* section of the *General* options provides the ability to select the kind of error logging you want to use in Skype for Business and whether or not to log system events.

![Help Your Support Team Help You Settings](image)

The *Logging in Skype for Business* option allows you to select the level of detail you want to provide in error logs and troubleshooting information. You can choose one of the three options available in the drop-down menu.

- **Full**: Provides all relevant details pertaining to errors and troubleshooting.
- **Light**: Provides minimal error information related to errors and troubleshooting.
- **Off**: Provides no error or troubleshooting information.

Select the desired option from the drop-down menu.

Also in this section is the *Also collect troubleshooting info using Windows Event logging* option. This option turns on Windows Event logging for Skype for Business and can provide helpful information to support staff in the event you need assistance with Skype for Business. Select this option if you want to enable Windows Event logging for Skype for Business.

Application Window Settings

The *Application Window* settings area contains a single configurable option. If you want Skype for Business to minimize to the notification area instead of the task bar when you select the option to minimize the Skype for Business window, select the corresponding checkbox.

![Application Window Settings](image)

This completes the *General* options configuration. Proceed to the *Personal* settings option to continue configuring Skype for Business.
The Personal Settings

The *Personal* settings govern how you want Skype for Business to function when opened, when your computer starts, and other such settings. The *Personal* settings are divided into four (4) sections. Configure all four sections, as is appropriate.

![Skype for Business - Options](image)

The My Account Settings

The *My account* section provides the ability to designate the actions you want to occur when the program begins running. The *My account* settings contains three options you may configure.

![My account](image)
Enter your e-mail address in the *Sign-in address* field. Entering your e-mail address in this field will prevent you from needing to enter your e-mail address each time you log into Skype for Business.

Next, if you would like Skype for Business to launch when you log into Windows, select the **Automatically start the app when I log on to Windows** checkbox. Selecting this option will automatically start Skype for Business each time you log on to Windows.

The last setting in this section designates where you want the Lync window to display when it launches. If you want Skype for Business to run in the background, uncheck the **Start the app in the foreground** checkbox. If you want Skype for Business to run in the foreground, leave this checkbox selected.

Proceed to the *Personal information manager* settings when you have finished working with the *My account* settings.

**The Personal Information Manager Settings**

The *Personal information manager* settings provides the ability to designate how you want Skype for Business to integrate with the Microsoft Exchange Server and/or Microsoft Outlook. You can also designate how you want Skype for Business to save and store IM and call logs.
To begin, verify that **Microsoft Exchange or Microsoft Outlook** is selected and displayed in the drop-down menu. Next, configure the following settings for Skype for Business and Microsoft Exchange/Outlook integration.

- **Update my presence based on my calendar information:** If you would like your Skype for Business status to be automatically updated based on your Outlook Calendar information, leave this checkbox selected. For example, when you are scheduled to be in a meeting, Skype for Business will display your status as Busy for the duration of the scheduled meeting. You can change your status manually, at any time. If you do not want Skype for Business to change your Skype for Business status, deselect this checkbox.

- **Show meeting subject and location to contacts in my Workgroup privacy relationship:** When this setting is enabled, contacts with a privacy relationship of "Workgroup" can see the name of the meeting and the meeting location, when Skype for Business is configured to automatically update your status based on your Microsoft Outlook information. By default, this option is enabled. If you want to disable this setting, deselect the corresponding checkbox.

- **Show my Out of Office info to contacts in my Friends and Family, Workgroup, and Colleagues privacy relationships:** If you want your Out of Office message to be displayed for individuals with a privacy relationship of "Friends and Family," "Workgroup," or "Colleagues," leave this checkbox selected. If you do not want your Out of Office information provided to these contacts, deselect the corresponding checkbox.

- If you want your IM conversations to be saved in your email Conversation History folder, leave the **Save IM conversations in my email Conversation History folder** checkbox enabled. Deselect this checkbox to turn this feature off.

- If you want a log off all calls you send and receive within Skype for Business to be saved in your email Conversation History folder, leave the **Save call logs in my email Conversation History folder** checkbox enabled. Deselect this checkbox to turn this feature off.

Proceed to the **Location** settings when you have finished working with the **Personal information manager** settings.
The Location Settings
The *Location* section contains one configurable setting. The *Share my location info with other programs I use* checkbox can be selected if you want your location information to be shared with other programs that you use.

---

<table>
<thead>
<tr>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Share my location info with other programs I use</td>
</tr>
</tbody>
</table>

Proceed to the *Show pictures* settings when you have finished working with the *Location* settings.

The Show Pictures Settings
The *Show pictures* section contains one configurable setting. If you want to view the profile pictures of your contacts within Skype for Business, leave this checkbox enabled. If you do not want to view contact pictures, deselect the *Show pictures of contacts* checkbox. However, if you disable the displaying of profile pictures, your own profile picture is disabled from being viewed.

---

<table>
<thead>
<tr>
<th>Show pictures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: Clearing the box turns off all pictures in the app including yours.</td>
</tr>
<tr>
<td>☑ Show pictures of contacts</td>
</tr>
</tbody>
</table>

This completes the *Personal* options configuration. Proceed to the *Contacts List* settings option to continue configuring Skype for Business.
The Contacts List Settings
The *Contacts List* settings govern how you want Skype for Business to function when you start the application. The *Contact List* settings are divided into three (3) sections. Configure all three sections, as is appropriate.
My Contacts List Settings

The *My Contacts list* section provides the ability to designate how you want contacts to be displayed on your Contact List. You can elect to display your contacts with their name and picture, or just their name. Select the radio button that is adjacent to the option you want to use.

Proceed to the *Order my list* settings when you have finished working with the *My Contacts List* settings.

Order My List Settings

The *Order my list* settings provide the ability to designate how you want contacts to be ordered within your Contact List. You can elect to order your contacts with their name or by their availability. Select the radio button that is adjacent to the option you want to use.

Proceed to the *Show this information* settings when you have finished working with the *Order my list* settings.
Show This Information Settings

The *Show this information* section provides the ability to designate what information about your contacts is displayed within your Skype for Business Contact List. Select which, if any, of the following option you want to utilize.

- **Contact name (instead of email address):** If you want to display your contacts by their names instead of their e-mail addresses, leave this checkbox selected. If you want your contacts displayed by their e-mail address, deselect the corresponding checkbox.

- **Contact status:** Select this option if you want to view the status (Away, Busy, etc.) of your contacts. Deselect the corresponding checkbox if you do not want to view their status.

- **Show contacts with away, offline and unknown presences in a separate group:** If you want contacts with one of these statuses to be placed into a special group, leave this option selected. If you do not want to use this option, deselect the checkbox.

- **Favorites group:** If you want to make use of a Favorites group, leave this option selected. If you do not want to use a Favorites group, deselect this option.

This completes the *Contact List* options configuration. Proceed to the *Status* settings option to continue configuring Skye for Business.
The Status Settings
The Status settings provide the ability to designate how Skype for Business displays your status, in specific scenarios. Select the appropriate settings, based on your preferences.

The Status settings contain the following options.

- **Show me as Inactive when my computer has been idle for this many minutes**: You can designate how long you can be idle (your computer is on and logged in, but is unattended) before Lync changes your status to reflect you are idle. You can select any time interval between 5 and 360 minutes. It is recommended that you do not use a time interval of less than 5 minutes. Use the up and downward pointing arrows to increase and decrease the time displayed. You may also directly enter the number of minutes by typing the desired length.
• **Change my status from Inactive to Away after this many minutes:** After a certain amount of time, you will want Lync to change your Inactive status to Away, to alert your contacts that you are not present at this moment. You can designate how long you can be inactive before Lync changes your status to Away. You can select any time interval between 5 and 360 minutes. It is recommended that you do not use a time interval of less than 5 minutes. Use the up and downward pointing arrows to increase and decrease the time displayed. You may also directly enter the number of minutes by typing the desired length.

• **I want everyone to be able to see my presence regardless of system settings (override default settings):** This option and the next option are related. If you want everyone using Lync to be able to see your online presence, regardless of the system settings, select this radio button.

• **I want the system administrator to decide - currently everyone can see my presence but this could change in the future:** This option is related to the previous option. If you want the system administrator to decide how and when Lync users see your online presence, select this radio button.

• **Show me as Do Not Disturb when I present my desktop:** When you are sharing your screen or desktop with Lync contacts, Lync can automatically change your status to Do Not Disturb, so that messages will not be received during this time. Select this option to enable this feature.

• **Show me as Do Not Disturb when my monitor is duplicated:** When you are using your computer in conjunction with a projector or other duplication device, Lync can automatically change your status to Do Not Disturb, so that messages will not be received during this time. Select this option to enable this feature.

This completes the *Status* options configuration. Proceed to the *My Picture* settings option to continue configuring Skype for Business.
My Picture Settings

The *My Picture* settings provide the ability to show or hide your profile picture. If you select the **Hide my picture** option, your picture will not display in Skype for Business (though it may display other places, depending upon your configuration). If you select the **Show my picture** option, your profile picture is displayed to your contacts.
Edit or Remove Picture

By selecting the Edit or Remove Picture button, you can select a new profile picture to display, or remove your profile picture altogether.

Select the Edit or Remove Picture button. A browser window launches and you will receive a user name and password prompt, similar to the following.

![Password Entry](image)

Enter your USC e-mail address in the User Name field. Next, enter your corresponding password and then select the OK button. The Account Information page displays.
Select the black X (🗙) to remove your photo. Select the **Browse...** button to locate a local image that you want to display as your profile picture. This picture is connected to your Microsoft Outlook profile, so you will want to select an appropriate image.

After you have selected an image to use as your profile picture, select the **Save** button, located at the bottom right side of the screen.

Skype for Business now displays the image you selected as your profile picture. It may take a few minutes for your contacts to be able to see the new picture.

This completes the *My Picture* options configuration. Proceed to the *Phones* settings option to continue configuring Skype for Business.
The Phones Settings

The *Phone* settings provides the ability to configure information related to telephones and placing calls. This screen is divided into four (4) sections. Configure all four sections, as is appropriate.
My Phone Numbers Settings

The *My phone numbers* section provides the ability to add or edit the numbers associated with your profile.

The **Work Phone...** field is supplied by payroll and HR records and cannot be edited within Skype for Business. The **Mobile, Home, and Other Phone...** fields can be edited. Select the button associated with the number you want to configure. The *Edit Phone Number* screen displays.

Enter the phone number you want to add and then select the **OK** button. The phone number entered is now displayed in the *My phone numbers* section.

Proceed to the *Phone integration* settings when you have finished working with the *My phone numbers* settings.
The Phone Integration Settings
The *Phone integration* section contains one option. This option is not currently supported and, therefore, is not available to be configured.

![Phone integration settings](image)

Proceed to the *Phone Accessibility* settings when you have finished working with the *Phone integration* settings.

The Phone Accessibility Settings
The *Phone accessibility* section provides the ability to use TTY to communicate via text over a telephone line. TTY is commonly used in devices made for the hearing impaired, and translates telephone conversations into readable text, much like Closed Captioning in television programs.

![Phone accessibility settings](image)

If you want to enable TTY, select the Turn on TTY mode checkbox.

This completes the *Phones* options configuration. Proceed to the *Alerts* settings option to continue configuring Skype for Business.
The Alerts Settings
The *Alerts* settings provides the ability to configure when alerts are received. This screen is divided into three (3) sections. Configure all three sections, as is appropriate.
The General Alerts Settings

The **General alerts** section provides the ability to designate whether or not you want to receive an alert when a person adds you to their Contact List. You can also decide where the alerts will appear on your workstation.

![General alerts settings](image)

Select the **Tell me when someone adds me to his or her contact list** option to enable this feature. You will receive an alert message that notifies you that you have been added to an individual’s contact list, when this feature is enabled.

Next, select where you would like the alert to appear. You can select the monitor, if you have multiple monitors in use, on which you would like to alert displayed. You can also select the position of the alert on the screen, such as the lower-right corner of the screen.

Proceed to the **When my status is Do Not Disturb** settings when you have finished working with the **General alerts** settings.

The When my status is Do Not Disturb Settings

This section of the Alerts settings corresponds to what actions you want Skype for Business to take when your status is set to Do Not Disturb.

![When my status is Do Not Disturb settings](image)

Select the radio button that corresponds to the option you want to use.

- Don’t show alerts
- Show only conversation alerts from people in my Workgroup privacy relationship
- Show all alerts, but only conversation alerts from people in my Workgroup privacy relationship

Proceed to the **Contacts not using Skype for Business** settings when you have finished working with the **When my status is Do Not Disturb** settings.
The Contacts Not Using Skype for Business Settings

This section of the Alerts settings corresponds to how you want Skype for Business to behave regarding contacts that are not using Skype for Business.

Select one of these options to indicate how you want Skype for Business to address non-Skype for Business users adding you to their Contact List.

- Block all invites and communications
- Allow invites but block all other communications
- Allow anyone to contact me

By default, the Allow invites from domains my admin hasn't verified (You'll only hear from people in these domains if they're on your Contacts list.) option is enabled. If you want to disable this option, deselect the corresponding checkbox.

This completes the Alerts options configuration. Proceed to the IM settings option to continue configuring Skype for Business.
The IM Settings

The IM settings section allows you to designate how you want the Skype for Business message window to function. There are five (5) settings that can be configured, within the IM settings.
There are five options to configure within the IM settings section. Configure the options as is appropriate for your Skype for Business use.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check spelling as I type</td>
<td>If you want Skype for Business to automatically check the text you type for spelling errors, select this option.</td>
</tr>
<tr>
<td>Hide pictures in IM</td>
<td>If you do not want to automatically display images your contacts’ profile picture in the IM window, select this option. You will no longer see</td>
</tr>
<tr>
<td>When copying IMs</td>
<td>The When copying IMs section has two options to choose from. When you are copying and pasting the text of a message, you can include or exclude the sender information, such as the person’s name and date/time stamp. Select the option that best meets your needs.</td>
</tr>
<tr>
<td>Show emoticons in messages</td>
<td>By default, the Show emoticons in messages option is selected. If you do not want to show emoticons in messages, select Turn off emoticons animations.</td>
</tr>
<tr>
<td>Enable tabbed conversations</td>
<td>By default, the Enable tabbed conversations option is selected. This option condenses multiple conversations into a single window. If you do not want your conversations to appear in a tabbed format, deselect this option.</td>
</tr>
<tr>
<td></td>
<td>If you want the tabs in that window to be displayed with a single information line, select the Make tabs one line only checkbox.</td>
</tr>
</tbody>
</table>

Proceed to the Ringtones and Sounds settings option to continue configuring Skype for Business.
The Ringtones and Sounds Settings
The *Ringtones and Sounds* settings provides the ability to configure when a sound alert plays and which sound alert plays. This screen is divided into two (2) sections. Configure both sections, as is appropriate.
The Ringtones Settings

To set the ringtone that will play with a specific phone number, select the phone number in the Calls to: column (in this example, the label is My work number). Then, select an item from the Ringtone: column. As a sound file is select in the Ringtone: column, the sound will play. When an item in both columns is selected, you are finish working with the Ringtone settings.

![Ringtones Settings](image)

The Sounds Settings

The Sounds section contains the settings that govern when a sound will play within Skype for Business.

![Sounds Settings](image)

Select one or more of the checkboxes within this section to enable the setting.

- **Play sounds (including ringtones for incoming calls and IM alerts)**
  - Mute incoming IM alert sounds when viewing an IM conversation
  - Keep sounds to a minimum when my status is Busy
  - Keep sounds to a minimum when my status is Do Not Disturb

The Play music on hold option is disabled by default because this feature is not currently supported.
At the bottom of this section is the **Sound Settings** button. Selecting this button displays the Windows **Sound** menu. From this menu, you can preview and change the sounds that Skype for Business will play when an action occurs.

Complete these steps to select a sound file to use with Skype for Business.

1. Using the scroll bar, locate the **Lync** sounds in the list. Skype for Business was previously called Microsoft Lync and is still listed as such on the **Sounds** menu.
2. Highlight the name of a sound. The **Sounds** field displays the name of the sound file and the **Test** button becomes available.
3. To hear the current sound file, select the **Test** button.
4. To choose a different sound, select the **Browse...** button and locate the sound file you would like to use for the selected event.
5. When you have finished reviewing and editing the Lync sounds, which impact Skype for Business, select the **OK** button to save your changes and exit the **Sounds** window.

This completes the **Ringtones and Sounds** options configuration. Proceed to the **Audio Device** settings option to continue configuring Skype for Business.
The Audio Device Settings
The *Audio Device* settings provides the ability to configure speaker and audio-related options. This screen is divided into three (3) sections. Configure all three sections, as is appropriate.
The Audio Device Settings

The *Audio device* section provides the ability to select which speakers, microphone, and ringer are used in Skype for Business.

First, **Select the device you want to use for audio calls** by selecting the drop-down menu associated with this setting. If you only have one microphone and one speaker associated with your computer, the system defaults will be the only option available in this menu. If you have more than one microphone and/or speaker, select the name of the device you want to use with audio calls, from the drop-down menu.

Under **Customize your device**, you can select which speaker and microphone you want to use with Skype for Business when not related to an audio call. Select the corresponding drop-down menu to select a speaker or microphone for use with Skype for Business. Underneath the *Microphone* drop-down menu, a sound indicator is displayed. When your microphone is registering sound, the indicator displays that the sound is being detected.

The *Ringer* option provides the ability to play the sound associated with an incoming audio call within Skype for Business. The *Ringer* sound cannot be changed on this screen. Go to the *Ringtones and Sounds* settings to edit the *Ringer* sound file.

Proceed to the **Secondary ringer settings** when you have finished working with the *Audio device* settings.
The Secondary Ringer Settings

The Secondary Ringer settings contains two configurable settings. Configure these options as is appropriate.

If you have more than one audio device connected to your workstation or device, and you would like a secondary audio devices to "ring" when a Skype for Business call is received, select the Also ring checkbox. The adjacent drop-down menu becomes available for selection. Select the audio device you would like to designate as the secondary ringer when you receive a Skype for Business call.

Next, if you would like to automatically unmute your workstation speakers when you receive a Skype for Business call, select the Unmute when my phone rings checkbox.

After configuring the Secondary Ringer settings, proceed to the Stereo Audio Playback settings.

The Stereo Audio Feedback Settings

The Stereo audio playback section contains one configurable option. You can select the Allow stereo audio playback when available checkbox to allow a higher audio quality, when available. Deselect this checkbox to disable this option.

This completes the Audio Device options configuration. Proceed to the Video Device settings option to continue configuring Skype for Business.
The Video Device Settings

The *Video Device* settings provides the ability to configure webcam-related options. This screen is divided into two (2) sections. Configure both sections, as is appropriate.
The Video Device Settings

The Video device settings section provides the ability to select the webcam you want to use with Skype for Business.

If you have multiple webcams attached to your computer, you can select which one you would like to use with Skype for Business. Select the drop-down menu and choose the name of the webcam you want to use with Skype for Business. If the webcam is functioning correctly, a preview image of the webcam's feed is displayed in the center of the section.
If the image being displayed by the webcam needs to be adjusted, select the **Camera Settings** button. The *Properties* window displays.

Adjust the settings as is appropriate. When you have finished adjusting the camera settings, select the **OK** button to save your changes.

Proceed to the Video Settings options when you have finished working with the *Video device* settings.

**The Video Settings**

The *Video settings* section contains one configurable option. You can select the **Crop and center my video meetings** option if you want your video feed to be cropped and centered within Skype for Business meetings. Deselect this option to turn this feature off.

This completes the *Video Device* options configuration. Proceed to the *File Saving* settings option to continue configuring Skype for Business.
The File Saving Settings

The *File Saving* settings contains one configurable option. You can select the location to which you want to save files that are received through Skype for Business. You can use the default location, or, select the *Browse*... button and choose a new location to which all files received within Skype for Business will be saved.

![Image of Skype for Business - Options window]

This completes the *File Sharing* options configuration. Proceed to the *Recording* settings option to continue configuring Skype for Business.
The Recording Settings
The **Recording** settings provides two configurable options related to recordings within Skype for Business.

![Skype for Business - Options](image)

The **Recordings** settings provide the ability to select the location to which recordings made within Skype for Business will be saved. Skype for Business was previously called Microsoft Lync, therefore, the name "Lync" is used in the default file save location.

![Recordings Save to](image)

The default location is displayed in the **Save to:** field (this location may vary). To select a new location to which you want to save your recordings, select the **Browse...** button. Select the new
When you are finished, select the OK button. The new location is displayed in the Save to: field.

When you are finished adjusting the save location for Skype for Business recordings, proceed to the Image resolution settings.

**The Image Resolution Settings**

In this section, you have the ability to select the resolution of images/recordings within Skype for Business. The higher the resolution, the better the image quality. However, a higher resolution imaging can slow down your Internet connection speed.

<table>
<thead>
<tr>
<th>Image resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The higher the resolution, the larger the file size.</td>
</tr>
<tr>
<td>○ 480p</td>
</tr>
<tr>
<td>○ 720p HD</td>
</tr>
<tr>
<td>○ 1080p Full HD (highest)</td>
</tr>
</tbody>
</table>

Select the radio button next to the resolution you want to use.

This completes the Recording options configuration. Proceed to the Skype Meetings settings option to continue configuring Skype for Business.
The Skype Meetings Settings
The Skype Meetings settings provides the ability to configure meeting-related options. This screen is divided into two (2) sections. Configure both sections, as is appropriate.

The When I Join Meetings Setting
The When I join meetings settings control what actions will occur when you are conducting or participating in a Skype for Business meeting. Configure the following settings.

- **Show IM**: Select this setting if you would like the IM portion of the meeting room displayed when you join a meeting.
- **Show the participant list**: Select this setting if you want the meeting participant list displayed.

After you have finished configuring these settings, proceed to the Meeting default settings.
The Meeting Default Settings

The Meeting default section contains one configurable option. If you have multiple versions of Skype installed, you can select which version you want to use for meetings.

Select the Change... button. A selection screen displays.

How do you want to open this type of link (lync15)?

- Keep using Skype for Business (desktop)
- Look for an app in the Store

Select the version of Skype you want to use with meetings. The default version of Skype, for meeting purposes, is now set.

The Skype for Business Settings configuration is now complete. Select the OK button at the bottom of the screen to save your changes.
CHAPTER 7: PRESENTATION TOOLS
WITHIN SKYPE FOR BUSINESS

When using the presentation functionality, Skype for Business provides you with many options to be able to conduct sharing sessions effectively.

Presentation Tools
After launching a message window, select the Present icon. The Presentation Tools menu displays.

From the Presentation Tools menu, you can select how you want to share information.
Select one of the following options to begin a presentation and to share information.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Present Desktop...</td>
<td>Select this option to share your desktop with the meeting/message. All message recipient(s) and meeting attendee(s) will be able to see your workstation's desktop and the items that you display.</td>
</tr>
<tr>
<td>Present Programs...</td>
<td>Select this option if you only want to share a specific program with the message recipient(s) and meeting attendee(s). Selecting this option aids in preventing the unintentional sharing of confidential information.</td>
</tr>
<tr>
<td>Present PowerPoint Files...</td>
<td>Select this option if you want to display a PowerPoint presentation file with the message recipient(s) and meeting attendee(s).</td>
</tr>
<tr>
<td>Add Attachments...</td>
<td>Select this option if you want to add attachments to the message/meeting window. You can attach image, sound, video, and other documents.</td>
</tr>
<tr>
<td>Shared Notes...</td>
<td>Select this option if you have a Microsoft OneNote file that you would like to share with the message recipient(s) and meeting attendee(s)</td>
</tr>
<tr>
<td>My Notes...</td>
<td>Select this option to choose the Microsoft OneNote notebook to which you want to add notes from this message/meeting.</td>
</tr>
<tr>
<td>More...</td>
<td>Select this option to display additional menu items. From More..., you can select the Whiteboard, Poll, and Q &amp; A.</td>
</tr>
<tr>
<td>Manage Presentable Content</td>
<td>Select Manage Presentable Content to view and manage content that you have made available during messages/meetings within Skype for Business.</td>
</tr>
<tr>
<td>Manage Notes</td>
<td>Select this option to work with Microsoft OneNote notebooks that you have created or edited during Skype for Business messages/meetings.</td>
</tr>
</tbody>
</table>
Using the Whiteboard

Using the Whiteboard functionality within Skype for Business is simple and effective. The Whiteboard provides the ability for all participants to interact with communication tools to brainstorm ideas or work through concepts.
On the right side of the Whiteboard, you can select which tool you want to use on the Whiteboard. Select from one of the following options.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laser Pointer</td>
<td>Select the Laser Pointer tool to use a laser pointer to draw your attendees' attention to an item or area on the Whiteboard.</td>
</tr>
<tr>
<td>Text Tool</td>
<td>Select the Text tool to insert a text area on the Whiteboard. Use the drop-down menu to adjust the color and size of the text.</td>
</tr>
<tr>
<td>Pen Tool</td>
<td>Select the Pen tool to write on an area of the Whiteboard. Use the drop-down menu to adjust the color and size of the writing.</td>
</tr>
<tr>
<td>Highlighter</td>
<td>Select the Highlighter tool to highlight on an area of the Whiteboard. Use the drop-down menu to adjust the color and size of the highlighting.</td>
</tr>
<tr>
<td>Eraser Tool</td>
<td>Select the Eraser tool to remove an object on an area of the Whiteboard.</td>
</tr>
<tr>
<td>Stamp Tool</td>
<td>Select the Stamp tool to place a checkmark or an X on an area of the Whiteboard. Use the drop-down menu to select a specific stamp.</td>
</tr>
<tr>
<td>Shape Tool</td>
<td>Select the Shape tool to draw a shape on an area of the Whiteboard. Use the drop-down menu to adjust the color, size, and shape of the drawn.</td>
</tr>
<tr>
<td>Delete Annotation</td>
<td>Select the Delete Annotations tool to remove a text area of the Whiteboard.</td>
</tr>
<tr>
<td>More Options</td>
<td>Select the More Options tools to display a traditional Windows menu, containing such options as Copy, Paste, and Save As.</td>
</tr>
</tbody>
</table>

Use these tools in conjunction with the Whiteboard to make the best use of Skype for Business and its resources.
Creating a Poll
During your sharing session, you may want to create a poll to gain a response from your participants. Skype for Business provides the option to create a poll. Select Present > More...> Poll. A screen similar to the following appears.

![Create a Poll](image-url)
Enter a name for the poll, the question, and the poll choices. When you have finished entering these items, select the **Create** button. The poll is placed into the Skype for Business presentation area.

You can configure whether or not to allow participants to see the poll results, close the poll, and other actions, by selecting the **Poll Actions** menu.
Using the Q & A Feature

The Q & A feature provides the ability to perform a formal question and answer segment within your Skype for Business meeting/message. This feature is particularly useful when you have 3 or more message/meeting attendees and you want to be able to take and answer questions that have arisen from your presentation.

To access the Q & A feature, navigate to Present > More... > Q & A. A screen similar to the following displays.

![Image of Q & A feature]

The Q & A feature provides the ability to pick and choose which questions you will answer. All attendees can ask a question, but the other attendees will only see the question when you have entered an answer to that question.

You can end the Q & A session by selecting the Stop Q & A button.
The Skype for Business Recording Manager is a component that assists in the management of recording files.

To launch the Recording Manager, select Tools > Recording Manager.

The Recording Manager displays.
The Recording Manager displays a list of all the recordings you have made in Lync, which you have not delete. From the Recording Manager you can:

- **Play**: View a recording
- **Browse**: Locate and open a recorded file
- **Publish**: Save a copy of a recorded file to a different location
- **Rename**: Rename a recorded file
- **Delete**: Delete a recorded file from your computer by highlighting the name of the file and selecting the **Delete** button

Use the Recording Manager to assist you in the management of recorded files from Skype for Business.
CHAPTER 9: SKYİPE FOR BUSINESS FOR MOBILE

To use Skype for Business on a mobile device, you will need to download the Microsoft Lync 2013 app from the Google Play Store or the Apple App Store. Look for one of the following icons.

iOS app icon  Android app icon
CHAPTER 10: SKYPE FOR BUSINESS BROWSER PLUGIN

Non-Skype for Business users can participate in Skype for Business meetings by utilizing the browser plug in to conduct the meeting.

1. To begin, select the **Skype for Business** meeting hyperlink.
2. Your default browser launches and displays the **Lync Web App**. Skype for Business was formerly called **Lync 2013** and is still branded as such in this instance.

3. Enter your name in the **Guest** field. You may enter your first or full name.
4. Next, select the **Join the meeting** option, located in the center of the screen. The **Lync Web App** displays.

You can now participate in the Skype for Business meeting session.
Skype for Business makes conducting virtual meetings easier by integrating with Microsoft Outlook 2013. You can schedule a Skype for Business meeting with a single click from within Outlook 2013.

1. To begin, select the Calendar within Outlook 2013.
2. Next, select the **New Skype Meeting** option, located at the top of the screen.

![New Skype Meeting Option](image)

A new meeting invitation displays.

3. The new meeting invitation that displayed after selecting the **New Skype Meeting** option contains Skype meeting information. Outlook 2013 has created and inserted a Skype for Business meeting and the corresponding hyperlink to that meeting.

4. Populate the blank meeting invitation with the information you would normally include, such as the location, the attendee(s), and a description of the meeting's purpose.

5. When you have finished populating all of the meeting information, select the **Send** button to send your meeting invitation.

Additionally, you can access the **Meeting Options** menu from the top of a blank meeting invitation. This menu provides a few options for controlling Skype for Business options when conducting your meeting.

You can also select **Join Skype Meeting** from the top of a blank meeting invitation. When selected, a Skype for Business meeting will immediately launch. You can then invite Skype for Business users from your organization from the meeting window. If you need to invite a non-Skype for Business user, you cannot use the **Join Skype Meeting** option. You will need to send an invitation to the non-Skype for Business users so that they can cannot via an Internet browser plugin.
CHAPTER 12: SKYPE FOR BUSINESS WEB SCHEDULER TOOL

The *Skype for Business Web Scheduler Tool* provides the ability to schedule Skype for Business meetings via the Internet. You can invite Skype for Business users within your organization, as well as non-Skype for Business users.

Follow the steps below to schedule a Skype for Business meeting via the Web Scheduler Tool.

1. Navigate to [https://sched.lync.com](https://sched.lync.com). You will be prompted to log into your Microsoft 365 account.

2. Enter your USC email address in the *Email or phone* field. If you have previously logged into your Microsoft 365 via your web browser, your USC email address may appear as an item you can select with your cursor. If your email address is displayed, select it to continue.

3. After entering your email address, press the **Tab** key on your keyboard -OR- place your cursor in the *Password* field.
4. You will be prompted to enter your email address and the corresponding password again.

5. Select the OK button. The Skype for Business Web Scheduler Tool displays.
6. The Skype for Business Web Scheduler Tool provides the ability to create a Skype for Business meeting. This is like a meeting you would create in Outlook or other calendar management programs, except that this meeting will include a video conferencing component and take place on Skype for Business. Populate the screen fields as follows to create a Skype for Business meeting.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Enter the name of the event that you are scheduling. For example, you might enter 'Software Training' or some other descriptive title.</td>
</tr>
<tr>
<td>Location</td>
<td>Enter the location of the meeting if there is a physical location associated with this meeting.</td>
</tr>
<tr>
<td>Message</td>
<td>Enter any instructions or notations that your attendees might need.</td>
</tr>
<tr>
<td>Attendees and Audio</td>
<td>Enter the full name (first and last names) of the individuals you want to invite to your Skype for Business meeting. Separate each entry (an entry is the full name of an attendee. Example: John Doe is an entry) with a semicolon. Select the Check Names button to have the first and last name entries automatically converted to the registered email addresses of your attendees.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Enter the start time of your Skype for Business meeting.</td>
</tr>
<tr>
<td>End Time</td>
<td>Enter the end time of your Skype for Business meeting.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Enter the time zone of your meeting.</td>
</tr>
<tr>
<td>Who will bypass the lobby?</td>
<td>You can configure your meeting so that every person that joins the Skype for Business meeting is held in a virtual lobby until the organizer arrives. You can decide which users, if any, will be held in the virtual lobby before your call begins. Select the option you want to use from the drop-down menu.</td>
</tr>
<tr>
<td>People dialing in by phone will bypass the lobby</td>
<td>Select this option if you want all users dialing into your Skype for Business meeting via a telephone to bypass the virtual lobby.</td>
</tr>
<tr>
<td>Who is a presenter?</td>
<td>Make a selection from this drop-down menu to designate the individual (or individuals) that will be presenters during this meeting. If you only want certain individuals to have presenter permissions, this is where you make that designation. Depending on the option chosen, a secondary text box with a Check Names button, just like the one in the Attendees and Audio section displays. Enter the full name of each person and then select the Check Names button to have the full names converted to their registered email address.</td>
</tr>
</tbody>
</table>

Note: You can invite registered Skype for Business users and non-Skype for Business users.
7. Select the **Save** button, located on the bottom right, to schedule your Skype for Business meeting. A meeting confirmation displays.

8. Copy the meeting details.

9. Paste them into a blank email.

10. Send the email to each meeting participant.

Repeat these steps to schedule additional Skype for Business meetings.
CONTACT DORNSIFE TECHNOLOGY SERVICES

Campus Office:  
825 Bloom Walk, ACB 530  
Los Angeles, CA 90089-1486

Technical Support: 213-740-2775

E-mail: ts@dornsife.usc.edu